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INTRODUCAO - Objectivos
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Modelo HECRAS

Hydrologic Engineering Center
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Modelo HECRAS - Funcionalidades

P

calcula a curva de regolfo de escoamentos unidimensionais em rios
regime permanente, lentos ou rapidos, e regime variavel

transporte sedimentar em fundo movel

analise de qualidade da agua.

rede de canais - natural ou regularizada

considera pontes, coletores, diques, confinamentos longitudinais,
descarregadores e acudes

representacéao grafica LNEC |6



Modelo HECRAS - caracteristicas

* Modelo uni-dimensional — 1D
= Dominio de calculo sdo as seccdes
= Sem escoamento transversal

* Vantagens:
= Modelo bem conhecido;
= Rapido;
= Facil utilizacao;
= Grande estabilidade no calculo;

* Desvantagens:
= Escoamento unidirecional,;
= N&o ha manutencao do escoamento numa parte da secc¢ao;
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Modelo HECRAS - equacoes base

« Utiliza as equacdes da continuidade e dos momentos.

0 _ 0Q , 0(aQ’/A) oh _ -
Quap-0 RN a5 )0

* As perdas de energia sao calculadas:
= friccao - Manning Equation
= Coeficinte para contraccOes/alargamentos

h :@_I_ C alvlz - a2v22
29 29
« Equacdo dos momentos:

= Ressalto hidraulico, hidraulica de pontes, juncao de afluentes
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Modelo HECRAS — GUI
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Modelo HECRAS — mais informacao

http://www.hec.usace.army.mil/software/hec-ras/documentation.aspx

: m - us Army Corps of Engineers

A ABOUT NEWSLETTERS SOFTWARE PUBLICATIONS

Hydrologic Engineering Center

TRAINING VISITORS LINKS CONTACT

HOME > SOFTWARE > HEC-RAS > DOCUMENTATION

HEC-RAS

HEC-RAS
Features
What's New
Downloads
Documentation
Known Issues
Bug Report
Suggestions
Demo
Sponsors
Collaborators

Support Policy

The documentation for HEC-RAS consists of a User's Manual which describes how to use the interface; a
Hydraulic Reference Manual which describes the data required, equations used, solution technigues, and
modeling advice; and an Applications Guide which contains seventeen example applications of using various
aspects of HEC-RAS. All three documents are in PDF format and can be viewed online or downloaded. To view
online or download individual chapters, go to the manual's individual page with the links below.

The HEC-RAS documentation is automatically installed during the setup of the program and can be accessed
through the Help menu. To view the documentation without installing the program. you may use the links below.

= HEC-RAS 4.1, User's Manual
= HEC-RAS 4.1, Applications Guide
= HEC-RAS 4.1, Hydraulic Reference Manual

See the What's New page for the current release notes listing the bug fixes for this and previous releases. The
What's New page also summarizes the current version's features.

In addition to the above Manuals and Guides the following documents may also be of interest:

= RD-41, A Comparison of the One-Dimensional Bridge Hydraulic Routines from HEC-RAS,
HEC-2. and WSPRO, Sep 1995

= RD-42, Flow Transitions in Bridge Backwater Analysis, Sep 1995

= TD-39, Using HEC-RAS for Dam Break Studies, Aug 2014

US Army Corps
of Engineers
Hologe Engresng

HEC-RAS
River Analysis System

User's Manual

danuary 2010

e e e e cPDes

US Ariy Corps
of Engineers
Hydrolagic Engineering Center

HEC-RAS

River Analysis System
Applications Guide

Version 4.1
January 2010
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January 2010
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Modelo HECRAS — mais informacao

GO IE hec-ras i U
3

Web Imagens Videos Mapas Livros Mais - Ferramentas de pesquisa

Cerca de 417 000 resultados (0,21 segundos)

HEC-RAS - Hydrologic Engineering Center
www.hec.usace.army.milsoftware/hec-ras/ ~ Traduzir esta pégina
Welcome to the Hydrologic Engineering Centers River Analysis System (HEC-RAS) web
site. As the first of HEC's "Mext Generation” (MexGen) software ..

HEC-RAS Downloads HEC-RAS Hydraulic ...
HEC-RAS has been developed for the Hydraulic Reference Manual. Version
U.S. Army Corps of .. 4.1. January 2010 ...

HEC-RAS Documentation HEC-RAS Whats New

The decumentation for HEC-RAS Version 4.1 of HEC-RAS includes the
consists of a User's Manual ... following new features: New ..

HEC-RAS Applications Guide  Features
Applications Guide ... HEC-RAS is an HEC-RAS is designed to perform one-
integrated system of software .. dimensicnal hydraulic ...

Mais resultados de army.mil »

HEC-RAS - Wikipedia, the free encyclopedia
en.wikipedia.org/wiki/HEC-RAS ~ Traduzir esta pagina

HEC-RAS is a computer program that models the hydraulics of water flow through
natural rvers and cther channels. The pregram is cne-dimensicnal, meaning ...

HEC RAS Tutorial - YouTube

www.youtube comiwatch?v=LhOCmncetX4 -
j 13/03/2014 - Carregado por Isaac Wait
. HEC RAS Tuterial. Isaac Wait. SubscribeSubscribed ... HEC-
i1 RASby Abelardo Herencia Q. unsteady ...
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Modelo HECRAS — mais informacao
(1 Tube j

Filtros «

Cerca de 4 880 resultados

HEC RAS Basico 1

de Edison

Ha 2 anos - 23 420 visualizaces

Video en donde se muestra un ejemplo basico v practico para el disefo de un canal
tfrapezoidal con el uso del HEC RAS

OFICIAL | HD

HEC RAS Tutorial

de lsaac Wait

Ha 1ano + 18 988 visualizaghes
HD

TUTORIAL: SIMULACION BASICA CON HEC-RAS.

de Ingeniero Jesus

Ha 2 anos « 41 757 visualizages

Bueno, aqui esta el tutorial que algunos pidieron. Espero gue les sinva

Running HEC RAS model with real data HD
de Adam Gidabo

Ha 1 ano » 7 169 visualizagdes

HD

HEC-RAS and Civil2D, Part 1 of 3
de 127civileng
Ha 3 anos - 36 591 visualizaces

E Exporing 2 HEC-RA S model from a Civil 30 surface. Part 1 of 3. Creating a quick
and accurate floodplain model form a terrain ..

HD

Secciones con HEC-RAS 4.1.0
de Gustavo Andrés Villavicencio Ruiz
Ha 1ano » 9662 visualizacdes
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Modelo HECRAS — dados

1. Linhas de agua

2. Seccoes transversais

3. Rugosidades

4. Hidrograma da ruptura

5. CondicOes de fronteira de jusante
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Modelo HECRAS — dados
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Extensao HEC -GeoRAS

B E Hydrologic Engineering Center

m - uUS Army Corps of Engineers

@

A4 ABOUT NEWSLETTERS SOFTWARE PUBLICATIONS TRAINING VISITORS LINKS CONTACT

HOME > SOFTWARE > HEC-GEORAS > DOWNLOADS

HEC-GeoRAS is a GIS extension that provides the user with 3 set of procedures, tools, and utilities for the
preparation of GIS data for import into HEC-RAS and generation of GIS data from RAS output. While the GeoRAS
HEC-GeoRAS extension is designed for users with limited geographic information systems (GIS) experience, knowledge of GIS is
e advantageous. Users, however, must have experience modeling with HEC-RAS and have a thorough
understanding of river hydraulics to properly create and interpret GIS data sets.

Known |ssues

This package will install HEC-GeoRAS 10 2 and all its pre-requisites automatically. Documentation is available
from the programs Help menu.

Support Policy

ArcGlSs 10.2 (ArcView license) with the 30 Analyst and Spatial Analyst extensions are required.

Release Notes: The Animation Tool was not migrated to HEC-GeoRAS 10.2. The native ArcGIS Animation
Toolbar must be used.

Download HEC-GeoRAS 10.2 [Updated] Install Package (12.6 MB)

HEC-GeoRAS 10 Example Data Sets: |

Examples: [What are these datasets?]
- Wailupe Import Example (5.96 MB)
- Baxter Example (44.7 MB)
- Terrain Tiles Example (11.9 MB)

LNEC | 15
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Extensao HEC -GeoRAS - Funcionamento
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Extensao HEC -GeoRAS - GUI
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Extensao HEC -GeoRAS - Aplicacao
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Extensao HEC -GeoRAS — mais informacao
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Extensao HEC -GeoRAS — mais informacao

GO-:.‘r IE hec-georas o U
3

Web Imagens Videos Mapas Noticias Mais - Ferramentas de pesquisa

Cerca de 47 300 resultados (0,34 segundes)

HEC-GeoRAS - Hydrologic Engineering Center

www hec. usace.army.mil/'software/hec-georas/ = Traduzir esta pég'rna
HEC-GeoRAS is a set of procedures, tools, and utilities for processing geospatial data
in ArcGIS using a graphical user interface (GUI). The interface allows the _.
Downloads - Known Issues - Support Policy

HEC-GeoRAS Downioads - Hydrologic Engineering Center
www._hec usace army.mil_. /hec-georas/downloads.a... = Traduzir esta pégma
HEC-GeoRAS is a GIS extension that provides the user with a set of procedures, tools,
and utilities for the preparation of GIS data for import inte HEC-RAS and .

HEC GeoRAS - GEOMETRIA (HEC-RAS) - YouTube
- www.youtube_com/watch 2v="uOLSMMTXEB0
2 ' 03/01/2014 - Carregado por Hidraulica para todos
A partir de |as curvas de nivel se genera un Moedelo Digital de
Elevacion y con |la extensién de ArcGIS "HEC ..

— e

HEC-GeoRAS y HEC-RAS - YouTube

= St www.youtube com/watch?v=HWVhEWqU70 ~
14/03/2014 - Carregado por Josue Diaz
En este video se muestran los pasos para crear los archivos en
Hec-GeoRAS que seran exportado a HEC-RAS .

HEC-Georas-Tutorial -1-Floodplain Map - YouTube

www . youtube comfwatch?v=kM2XWb5dNoQ -
14/03/20114 - Carregado por Yassir Abduljaleel

| In this tutorial we will be convert the DEM to Tin then build the
fleodplain map for a river in Spokane county

PO Tutorial on using HEC-GeoRAS 10.1 with ArcGIS 10.1 an...
web.engr.oregonsiate edu/. /Geo RAS/georastutoria... = Traduzir esta pagina
Adapted from HEC-GeoRAS - Hydrologic Engineening Center ... You can download
HEC-RAS and HEC-GeoRAS from the US Armv Corps of Enaineers.
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Extensao HEC -GeoRAS — mais informacao

YoullIB™ =-

hec-georas B Q

Cerca de 1 580 resultados

HEC-Georas-Tutorial -1-Floodplain Map

de Yassir Abduljaleel

Ha 1 ano = 7 289 visualizagbes

In this tutorial we will be convert the DEM to Tin then build the floodplain map fora
river in Spokane county

HD

HEC-GeoRAS y HEC-RAS

de Josue Diaz

Ha 1 ano = 11 500 visualizagbes

En esie video se muesiran los pasos para crear [os archivos en Hec-GeoRAS que
seran exportado a HEC-RAS. Los archivos del ..

HD

HEC-GeoRAS - GEOMETRIA (HEC-RAS)

de Hidraulica para todos

Ha 1ang - 7 511 visualizagBes

A partir de |as curvas de nivel se genera un Modelo Digital de Elevacion y con la
extension de ArcGIS "HEC-GeoRAS" se abtiene .,

HD

MODELACION DE RIiOS: Tutorial sobre el uso de HEC-GeoRAS con
ArcGls

de everfass

Ha 2 meses + 170 visualizagles
Windows 8 Pro / ArcGIS 10.2 far
2014,

HD

deskiop / HEC-GecRAS 10.2 / AutoCAD Civil 3D

HEC-GeoRAS
de Scott Isenberg
HEC_Georas_Tutorial -2- Floodplain Map g2z
HEC-Geoaras-Tutarial -1-Floodplain Map 12.07

er a lista de reproducdo completa (7 videos)

hecgeoras tutorial parte 1
de Reymundo Azael Martinez Castillo
Ha 3 anns » A 224 visualizaches
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APLICACAO - variaveis do sistema

= Delimitacdo da area em estudo
 Linhas de agua - limite de jusante
- Area inundavel

= Qutros elementos
* Acudes, diques, canais
* Ocupacéo do solo

= Hidrograma da ruptura

LNEC | 22



APLICACAO — Informacéo Base

= Levantamentos atualizados de:
 leitos dos rios e zonas adjacentes (1/500, 1/1000 ou 1/2000)
* infra-estruturas (acudes, pontes, etc)

= Cartografia da ocupacéao do territorio
» densidade populacional

 edificacOes/construcdes, rede viaria e ferroviaria, infra-
estruturas, zonas agricolas e atividades econémicas
existentes)

= Qutros estudos

LNEC | 23



APLICACAO — Informacéo Base

e Quais as fontes?

Observacdo em campo
Levantamentos

Organismos publicos locais e

centrais
Projetos/estudos anteriores

PublicacOes cientificas

nacionais e internacionais

 Tratamento da
Informacéao
* Analise da qualidade

* Verificacao com outras
fontes

* Adaptacéo para o
estudo

e Sistema de referéncia
unico para todos os dados:

= Ex: SIRGAS2000
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APLICACAO — MDT
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TIN

APLICACAO — MDT

©
N
O
Ll
=
—




APLICACAO — MDT: RASTER
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APLICACAO — MDT: TIN
- Escala

Cota

100 200
Distancia (m)

300

400

TIN original

Cota

100 200 300
Distancia (m)

400

TIN 10m

100 200 300 400
Distancia (m)

TIN 20m

Cota

0 100 200

Distancia (m)

300 400
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Cota

APLICA(;AO — MDT: RASTER
- Escala

TIN original
10 fomsmrmmmm e e P

Cota

-5 ;
200
Distancia (m)

0 100

Raster 5m

Raster 10m

200 300 4
Distancia (m)

200 300 a 0 100

Distancia (m)

100

Raster 20m

0 100

200 300 400

Distancia (m)
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APLICACAO — MDT: TIN vs RASTER

- Escala

TIN 5m

300

200
Distancia (m)

Raster 5m

Cota

Cota

400

300

200
Distancia (m)

Raster 10m

200

Distancia (m)

Distancia (m)

200 300 400
Distancia (m)
Raster 20m
10
[0 O I S—
%) SN S S — - 5 ]
-5 i i i i
0 100 200 300 400

Distancia (m)
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APLICACAO — Seccdes tipo

Montante

0 250 500 750
Distancia (m)

$332 (39,4 km)

Cota
(m)

1] 250 500 750 1000
Distancia (m)

v’ Secg¢do mais curta

v"  Leito central encaixado
v' Margens curtas

Jusante

$88 (18,4 km)

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

-5+ T T T T
0 1000 2000 3000 4000
Distancia (m)
$247 (32,2 km)
U S M A A !

Cota 20 ‘|
(m) 15 |

10 o
6|

6 560 10601560 20|00 2560 30I00 3500
Distancia (m)
Secgao larga
Leito de cheia com grande capacidade
Diques no leito central

Estuario

$10 (1,9 km)

1000 2000 3000
Distancia (m)

$32 (6,3 km)

0 250 500 750 1000
Distancia (m)

Seccao larga
Leito de cheia com grande capacidade
Termina sem diques
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APLICACAO — Ocupacéo do solo

VEGETACAO

CONSTRUCAO

LNEC | 32



APLICACAO — Ocupacéo do solo

* Fontes: « Analise das rugosidades
= Carta de Ocupagéo do Solo = Escolha do nimero de
= Fotografia aérea (Microsoft BING,Google,etc) classes
= Observagéo no local = Definigdo das areas

Observacéo do local

Carta de ocupacao de solos Fotografia aérea

http://jcduarte.net
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APLICACAO — Ocupacéo do solo

60 000 50 000 -40 000 -30 000

60000

50 000

OCUPAGAO DO SOLO

Curso de agua - leito Terreno improdutivo

Curso de agua - margens Vegetagao arbustiva

Areas pavimentadas abertas/vias de comunicagao Culturas de regadio/sequeiro/arrozais

Areas pavimentadas semi-ocupadas Pomar/floresta pouco denso

Edificado pouco denso Pomar/floresta denso : R

80 000

BXOUNM
i

Edificado denso Pomar/floresta muito denso
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APLICACAO — HIDROGRAMA DA RUPTURA DA
BRECHA

Dam (Inline Structure) Breach Data

Inline Structure IBaIcI Eagle Cr. Lock Haven 81454 ;J _JJ‘_I‘J Delete this Breach | Delete all Breaches |
v Breach This Structure

Breach Plot | Breach Proaression | Breach Repair foptionall |

Eentef S tation: |5250 Bald Baygle Creek Example Dam Break Shaly Plan: PMF - van TIwns Gllle | Breach Parame ks j
Final Bottom ‘Width: |381 =
Final Bottom Elevation: IEEIS I
Left Side Slope: |0.5 Glo:nd

: : ) Bank <t
Right Side Slope: IU,E Fhalsract

Breach ‘Weir Coef: [257
Full Formation Time [hrs): Insi
Faiwe Mode:  [Piping v |
Piping Coefficient: |057
Initial Piping Elev: 620 :
Trigger Failure at: lm 580 :

0 1000 2000 3000 4000 5000 6000 7000
Starting WS IE.'-"EAB
¥ Station (ft) P, (km 16,0)

Elevation (i)

m)

=
o

—— DAMBRK
——BIPLAN

(8]

Altura de agua (

0 1 2 3 4 5

Tempo (h)
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EXERCICIO EM HEC-RAS
HIDROGRAMA DA RUPTURA DA BRECHA
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EXERCICIO EM HEC-RAS
HIDROGRAMA DA RUPTURA DA BRECHA

 Projecto: Obidos
= HEC-RAS: File > Open Project > “Obidos01.prj”
= Pasta: CursoPAE_modulo2
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EXERCICIO EM HEC-RAS

CUIDADOS COM O HEC-RAS

Confirmar o sistema de unidades

= 1U5 Customary
+ Syztem International [Metric System)

(0] 4 i Cancel l Help

e O separador decimal do Windows deve ser o “.”

e O formato de data do Windows deve ser em inglés

-
¥ Personalizar Formate

i’

Mimeros | Moeda | Hora | Data

Exemplo
Positive:  123,456,789.00

Separador decimal:

M.? de casas decimais:
Simbolo de agrupamento de
digitos:

Agrupamente de digites:
Simbolo de sinal negativo:
Formato numérico negativo:
Apresentar zeros 3 esquerda:
Separador de lista:

Sisterna de medida:

Digitos padrdo:

Utilizar digitos nativos:

Megativo:

-123,456,789.00
F 2
3
(123,456,789 -
=
s =
@ 2
1 -
= .
0123456780 -]
[Nunca -

Clique em Repor para restaurar as predefinigdes do sistema Repor

relativas a nimeros, moeda, hora e data.

Cancelar | Aplicar

g
9 Regido e [dioma

il

Formatos | Localizacgéo I Teclados & Idiomas Mninjstﬁqa?’o!

Fermato:

[Inglés (Reino Unido)

Formatos de data e hora

Data abreviada: [dd!MMfaaaa VI
Data por extenso: [dd. MMM aaaa VI
Hora abreviada: [HH:mm 'l
Heora completa: [HH:mm:ss ‘]
1° dia da sernana: [Monday VI

@ que significa a notagdo?
Exemplos

Data abreviada: 04,/05/2015
Data por extenso: 04 May 2015
Hora abreviada: 19:00

Hora completa: 19:00:59

Aceder & Internet para informagdes para alterar Definigoes adicionais...

idiomas e formates regionais

Cancelar | Aplicar
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EXERCICIO EM HEC-RAS
HIDROGRAMA DA RUPTURA DA BRECHA

 Hidrograma da ruptura da brecha
= HEC-RAS: Geometric Data > Inline Structure > Breach (Plan Data)

Dam (Inline Structure) Breach Data

Inline Structure IBald Eagle Cr. Lock Haven 81454 L] ﬂﬂ Delete this Breach | Delete all Breaches |
v B h This Struct
EiXO Central da breCha - resac' = mclt;r:soi Breach F'lot] Breach Proaression | Breach Repair foptionall |
enter kalan: Bald Bagle Creek Example Dam Break Shaly Plam: PRIF = Van TIwns Gllle | Breach Parame ks -
Largura final da base da brecha Final Bottom Width: |31 =
Cota final da base da brecha Final Bottom Elevation: (565 720 TG
H . i : 05 oIt
Declive dos taludes laterais da brecha SR 700 o
Coeficiente de vazéo da brecha Fiapt Side Slpe - 650 Pt e
Breach Weir Coef: |2.B g ]
Tempo de formac&o total da brecha Ful Formation Time s} [06 | '3"’”1
Modo de ruptura: galgamento ou eros&o Faiure Mode: | Piping -2
intema Piping Coefficient: |U.5 620
. PPN Initial Piping Elewv: 620 600 -
Coeficiente de “piping rhidPpngElev: |
Trigger Failure at: |WS Elev v | 580

Cota inicial de “piping” Stating 5 ST 0 1000 2000 3000 4000 5000 6000 7000
8 Lo ' Stati =
Condicao para o inicio da rotura i el A,J

Valor de cota da superficie da agua 0K | Cancel |
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EXERCICIO EM HEC-RAS
HIDROGRAMA DA RUPTURA DA BRECHA

 Hidrograma da ruptura da brecha
= HEC-RAS: Geometric Data > Inline Structure > Breach (Plan Data)

Horizontal
Component of
Average Breach Side Failure
Breach Width Slope (H) Time, t;
Dam Type (Bave) (H:V) (hours) Agency

(0.5t03.0)x HD 0to 1.0 0.5 to 4.0 USACE 1980
(1.0t0 5.0)x HD 0to 1.0 0.1t0 1.0 FERC
e (2.0t0 5.0) x HD| 0 to 1.0 (slightly larger) 0.1t0 1.0 NWS
(0.5 to 5.0) x HD* 0to 1.0 0.1 to 4.0*| USACE 2007
Multiple Monoliths Vertical 0.1to 0.5 USACE 1980
Concrete Gravi Usually <05 L Vertical 0.1t00.3 FERC
v Usually < 0.5 L Vertical 0.1t00.2 NWS
Multiple Monoliths Vertical 0.1to 0.5 USACE 2007
Entire Dam Valley wall slope <0.1| USACE 1980
Concrete Arch Entire Dam 0 to valley walls <0.1 FERC
(08xL)toLL 0 to valley walls <0.1 NWS
(08xL)toL 0 to valley walls <0.1| USACE 2007
(08xL)toL 1.0t02.0 0.1t00.3 FERC
Slag/Refuse (08xL)toL <0.1 NWS

*Note: Dams that have very large volumes of water, and have long dam crest lengths, will continue to erode for long durations
(i.e., as long as a significant amount of water is flowing through the breach), and may therefore have longer breach widths and
times than what is shown in Table 3. HD = height of the dam: L = length of the dam crest: FERC - Federal Energy Regulatory
Commission; NWS - National Weather Service




EXERCICIO EM HEC-RAS
HIDROGRAMA DA RUPTURA DA BRECHA

e Simulacao de regime nao permanente
= HEC-RAS: Run > Unsteady Flow Analysis > Compute

&8 HEC-RAS 4.0.0

Ele Edt Run Yiew Options Hebp
|ﬁ'r|ﬂ||$(|:.|'gﬁ]m Psn: 37 Flood Evsting Conditbons - 31 ShoiD  [37Ewat 31
Proct [Singe Bndge - Exarpie 2 Geometry Fie [t Condtions Geometry 31 =
Planc Press/wes Method Unsteady Flow Fie : |97 Flood Event =
Steady Flow.  [Beaver Cr. - 3 Flows gogmaon:a
Unsteady Flow. | 5 Unsteady Flow Simd ]
Descrigton: | W Post Processor

Sweendation Tine Window

Starting Date: ETESE Stasting Teme:  [2200

\
Unsteady flow | Endm0se [ossenissr | EndngTme: [1500
: Computation Settings

analysis Computstionervat  [1Minte v] Hydogiaoh OuputIntenvat  [1How ~
I~ Computation Level Ouput Detaded Ouiput Intervat  [4How  ~|
DSS Output Flename: |C\HEC Data\HECRAS Prosecti\ Truckee\TruckeeRs G5
I Moed Flow Regme (see menu "Options/Meed Flow Options ")

Flow toughness changes

[c Compute )|
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EXERCICIO EM HEC-RAS

HIDROGRAMA DA RUPTURA DA BRECHA

e Visualizar resultados

[C:\Program Files (x8SAHEC\HEC-RAS\A.1.0AD am_F adure.g01

RASAS. 1.0ND am, &.pi|

[C:\Program Files (x86\HE! C-RAS\Y.1.0\Dam_F adure.p01

[C:-\Program Fies [m+msm C-RAS\A1.0\Dam_F adure.u02

= [ [ST0me

v 1 v
Open andsave |, Sediment data

Geometric data'Vater quality data

Steady flow data m

Unsteady flow data

L 4
Results (plots, tables, data,
errors ...)
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APLICACAO - Calibracdo do Modelo Numérico

* Analise das corridas do modelo
= Altura de escoamento / cota da superficie de agua
= Velocidades
= Numero de Froude —> regime rapido / lento
= Velocidade de propagacao & atenuacéo do hidrograma

e Calibracdo do modelo
= Hidrograma da brecha de ruptura
= Rugosidade — coeficientes de Manning
= |ntervalo de tempo de calculo - At
= Numero de Courant
= Qutros parametros caracteristicos do modelo
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CALIBRACAO - Rugosidades

observagoes

L
Leito principal

Leito principal - talvegue

Leito principal - margens

Leito principal - margens com arvores espacadas
Leito principal - margens com arvores densas

Areas artificiais

Areas pavimentadas abertas + estradas + parques de
estacionamento

Areas pavimentadas semi-ocupadas

Edificado espagado

Edificado denso

Campos

Descampado de areia/terra
Descampado + arbustos
Campo cultivado
Pomar/arvores espagado
Pomar/arvores denso
Pomar/arvores muito denso

A B C D E F
valores de I variagao valores valores valores
~ . variagao -20% " . "
referéncia +20% minimos  minimos ~ minimos
0.040 0.032 0.048 0.025 0.030 0.028
0.045 0.036 0.054 0.035
0.060 0.048 0.072 0.045 0.050 0.045
0.120 0.096 0.144 0.055
0.013 0.010 0.016 0.013 0.013 0.013
0.040 0.032 0.048 0.040 0.040 0.040
0.200 0.160 0.240 0.100 0.100 0.100
0.400 0.320 0.480 0.150 0.150 0.150
0.030 0.024 0.036 0.030 0.030 0.030
0.050 0.040 0.060 0.050 0.050 0.050
0.040 0.032 0.048 0.040 0.040 0.040
0.060 0.048 0.072 0.060 0.060 0.060
0.100 0.080 0.120 0.080 0.080 0.080
0.120 0.096 0.144 0.100 0.100 0.100
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CALIBRACAO - Rugosidades

Leito principal

Leito principal - talvegue

Leito principal - margens

Leito principal - margens com arvores espacadas
Leito principal - margens com arvores densas
Areas artificiais

Areas pavimentadas abertas + estradas + parques de
estacionamento

Areas pavimentadas semi-ocupadas

Edificado espagado

Edificado denso

Campos

Descampado de areia/terra
Descampado + arbustos
Campo cultivado
Pomar/arvores espagado
Pomar/arvores denso
Pomar/arvores muito denso

observagoes

valores de
referéncia

0.040
0.045
0.060
0.120

0.013
0.040
0.200
0.400

0.030
0.050
0.040
0.060
0.100
0.120

variagao -20%

0.032
0.036
0.048
0.096

0.010
0.032
0.160
0.320

0.024
0.040
0.032
0.048
0.080
0.096

C
variagao
+20%

0.048
0.054
0.072
0.144

0.016
0.048
0.240
0.480

0.036
0.060
0.048
0.072
0.120
0.144

D

valores
minimos

0.025
0.035
0.045
0.055

0.013
0.040
0.100
0.150

0.030
0.050
0.040
0.060
0.080
0.100

Combinagao final

E

valores
minimos

0.030

0.050

0.013
0.040
0.100
0.150

0.030
0.050
0.040
0.060
0.080
0.100

F

valores
minimos

0.028

0.045

0.013
0.040
0.100
0.150

0.030
0.050
0.040
0.060
0.080
0.100
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CALIBRACAO - Rugosidades

Cotas
(m)

0 10000 20000 30000 40000
Distancia (m)

valores de referéncia
Cota do fundo

— -10% valores de referéncia

+10% valores de referéncia
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CALIBRACAO - Intervalo de tempo

Corrida 1 | Corrida 2 | Corrida 3 | Corrida 4 | Corrida 5 | Corrida 6 | Corrida 7 | Corrida 8
At 30min 15min 5min 1min 30s 15s 5s 1s

Tempo de

corrida 00:04 00:05 00:12 00:49 01:35 03:08 07:11 12:24
(mm:ss)

Maximo

erro da 0.37 0.42 0.36 0.29 0.26 0.29 0.24 0.14
superficie

livre (m)

—

Erro maximo semelhante
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CALIBRACAO — Numero de Courant

* Espacamento entre de seccOes tem que ser adequadop araa
estabilizacdo do modelo

 Problemas

= |nstabilidade dos resultados -> variagdes bruscas das propriedades do
escoamento

= NUmeros de Courant > 1
= Algumas seccbes estavam demasiado proximas/longe

8.00

7.00

6.00

5.00

# Courant 4.00

3.00

2.00

1.00

U

I T T
0 10000 20000 30000 40000
Distancia (m)

0.00
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CALIBRACAO — Numero de Courant

e Como resolver?

= Homogeneizar / regularizar as distancias entre seccoes para
atingir nimero de Courant< 1

= Eliminar algumas seccoes

= Manter as seccdes mais criticas
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MAPA DE INUNDACAO - Construcéo

¥ o ot S Sorings SN g 501148 ED

S10(1,9 k) 832 (6,3 k)

i
ERCE- ]
£
PEEE-E-B-§-

1000 2000 3000 [ 250 00 TS0 1000
Distaneia (m) Distancia (m)
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MAPA DE INUNDACAO - Construcéo

[ o ot S Sorings SN g 501148 ED

S10(1,9 k) 832 (6,3 k)

PEEE-E-B-§-

] 1000 2000 3000 [ 260 00 TS0
Diiwtncia (m)

1000
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MAPA DE INUNDACAO - Construcéo

Superficie da agua
de cada cenario

- Sl

i ‘:"’ \\“ty‘ o
N_'\\‘ >, \ \‘ o
.W%_?u‘qml-nqgaguh. <5

e .

LRl
. ‘

. .“./
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DEMONSTRACAO DE HEC-GeoRAS
MAPA DE INUNDACAO
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DEMONSTRACAO DE HEC-GeoRAS
MAPA DE INUNDACAO
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MAPA DE INUNDACAO - Exemplo

Sistema de referéncia geografica: PT-TMOSETRSS9

LNEC | 55



CONCLUSOES

1. HEC-RAS + HEC-GeoRAS
sao ferramentas MUITO UTEIS

2. Os resultados dependem da qualidade dos dados:
= geometria das seccoes
= ocupacao do terreno
= hidrograma da ruptura

3. Os mapas de inundacao devem ser analisados e
discutidos com cuidado
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